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Wha t  i s  Jux ta ?  

Juxta is an open-source cross-platform tool for comparing and collating 

multiple witnesses to a single textual work.  The software allows users to 

set any of the witnesses as the base text, to add or remove witness texts, 

to switch the base text at will, and to annotate Juxta-revealed 

comparisons and save the results. 

 

Juxta presents several kinds of analytic visualizations.  The most basic 

collation offers a split frame comparison of a base text with a witness 

text, along with a display of the digital images from which the base text 

is derived.  Additionally, Juxta has several visualizations for the collation 

of multiple witnesses.  Juxta can display a heat map of the textual 

variants that allows the user to locate—at the level of any textual unit—

all witness variations from the base text. Users can also view the 

collation as a histogram, which displays the density of all variation from 

the base text and serves as a useful finding aid for variants in long 

documents.  Finally, Juxta can output a lemmatized schedule (in HTML 

format) of the textual variants in any set of comparisons. 

 

I n s t a l l i ng  Jux ta  

Juxta requires Windows XP or Mac OS X to run. If you received a Juxta 

CD, simply insert the CD in your computer and follow on-screen 

prompts. Otherwise, you must obtain the Juxta installer. Go to 

http://www.patacriticism.org/juxta and click on the “Download Juxta” 
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link. Save the installer to your computer and then double-click its icon to 

run it. Simply follow the prompts from there and Juxta will be ready for 

use. 

 

Ge t t ing  S t a r t ed  

The Juxta installation includes several sample collations, which can be 

accessed from the File menu. Select “File”, then “Open Sample”  

(File->Open Sample) and then select a JXT file for the sample you wish 

to view. The three sample collations are:  

 

Damozel—a collation of seven versions of the poem “The Blessed 

Damozel” by Dante Gabriel Rossetti. Demonstrates the use of Juxta XML 

files to associate images and milestones with text. 

 

Renaissance—a collation of two versions of Walter Pater’s Studies in the 

History of the Renaissance. Demonstrates the collation of prose texts. 

 

Whitman's Leaves of Grass— a collation of three versions of Walt 

Whitman’s “Leaves of Grass”. The source TEI XML was contributed by 

the Walt Whitman Archive. 

 

The Display Window, General. Opening a collation displays a list of 

witness documents on the left (in the Comparison Explorer panel) and on 

the right a transcription of one of the witness texts as the “base text” (at 

the beginning, it chooses the first of the listed witnesses). At the top is a 

menu with a set of standard editing functions for adding and removing 

witnesses, and for several other operations. Below this menu is a toolbar 

with a set of icons. Running the mouse over them displays the functions 

they perform. There is also an input box for entering words to search for 
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in all the texts in the comparison set. See the section on searching 

below. 

 

The upper panel at the right (Document Panel) displays a transcription of 

the base text. If the small (right) function box below the panel is clicked, 

the window splits to allow a comparison of texts to be displayed. The 

two small boxes above the text display area allow one to choose the 

comparison pair. The base text is always the left of the two. The lock 

icon between these two boxes (by default, “on”) can be clicked to 

unlock so that the comparison text transcription can be independently 

scrolled. 

 

The lower right panel is an area for displaying any annotations that have 

been made to the texts. Just below this lower right panel are four buttons 

that allow the user to control which information is displayed for the 

panel. When Juxta starts,  “Source” is display, which display's the source 

XML of the transcription in the Document Panel. “Images” sets the panel 

to display any digital images for the transcriptions, if they were included 

in the initial data. Images can be unlocked from their transcriptions in 

the panel above. In addition, the images can be zoomed in and out using 

the two small icons which appear at the bottom of the “Images” tab. 

Next, the “Notes” tab is displayed, which displays the user's annotations. 

The two small icons at the lower right allow the user to unlock the notes 

from their related transcriptions or to remove the notes. The “Moves” 

button displays all the moves that the user has specified. Clicking on a 

move scrolls the documents to display the moved text. The trashcan icon 

removes the currently selected move. Please see the section on creating 

moves, below. The "Search" button displays the results of the last search 
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operation. Clicking on a search item scrolls the texts to display the item 

in context. 

 

Collating and Annotating Operations, General. Clicking a witness text on 

the left will make that the base text. The box at the left of each witness 

text can be unchecked to remove it from the collation. The boxes to the 

right of each witness text visualize (in shades of blue) the global degree 

of difference between the base text and this witness, with degree of 

difference signaled by increase in the gradient color difference. 

 

In the right display panel, a "heat map" is superimposed (in blue) on the 

base text. Blue highlighting signals degrees of variance of the base text 

from the witnesses being compared. Clicking anywhere on the heat map 

produces a list of variants in a box in the right margin. You can also left-

click and drag the mouse to highlight a region and display all of the 

variants for the highlighted section. Clicking on the star in the pop up 

box allows you to enter annotations for that difference. 

 

You can create a new comparison set (File->New Comparison Set) and 

then add your own documents (Edit->Add Document). Documents must 

either be in a specific XML format – described later in this document – or 

in a plain text format. Loading a document automatically collates it using 

the current collation settings. 

 

Once the material has been collated, you can analyze the results, 

comparing differences among documents and interpreting the data. 

 

When you are ready to publish your work from Juxta, you can output a 

critical apparatus as an HTML document (File->Generate Critical 
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Apparatus). You can also save your comparison set (File->Save or File-

>Save As) for later work or for sharing with others who use Juxta. These 

outputs preserve all notes and annotations that have been created during 

the editorial operation. 

 

Collating passages that appear out of order. In the side-by-side difference 

view, indicate the moved passage by dragging the mouse over the 

passage in both the base and the witness texts. The move button (on the 

upper right, next to the selection of the witness text) will become 

enabled when text on both sides have been selected. Click the move 

button and the move will be created. You will see an outline of the 

passages and a line connecting them. There is also an entry in the Moves 

pane for each move created. Clicking the entry brings the move into 

view. 

 

Searching in all text. Juxta's search feature allows you to find a word or 

phrase in all the texts in the current collation set. Type the search terms 

you want in the input box that appears on the tool bar and press the 

enter key (or click in the icon to right of the input box). The results are 

displayed in the Search panel, and all the matching terms are highlighted 

in the texts. Clicking on a search result in the Search panel causes it to 

scroll into view. The search works for whole words only, so if you search 

for "work", for example, the term "working" will not be found. If you 

search for more than one word, then it finds them in any order, as long 

as they appear close to each other in the text. For instance, searching for 

"question be" in Hamlet will return (among other results) "be, that is the 

question." 
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Jux ta  Use r  In t e r f ace  

The Main Window is where most of the user interface resides. The major 

functional areas are shown below. Each of these panels can be resized 

by clicking and dragging its divider bar.  
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Toolbar 

 

 

The toolbar is a place to find the most commonly used functions in Juxta. 

From left to right, these functions are: 

 

Open Comparison Set - Loads a comparison set from a previously saved 

.jxt file. 

 

Save Comparison Set - Saves the current comparison set to a .jxt file. 

 

Add Document - Imports a new document into the comparison set (see 

Add Document Dialog). 

 

Remove Document - Removes the currently selected document from the 

comparison set. 

 

Edit Bibliographic Information - Edit the bibliographic information of the 

currently selected document (see Bibliographic Info Dialog). 

 

Find Text - Opens the Find Text Dialog for finding text in the currently 

selected document (see Find Dialog). 

 

Open Collation Histogram - Opens the Collation Histogram (see 

Collation Histogram Dialog). 

 

Generate Critical Apparatus - Generates a critical apparatus for the 

currently selected document (see Generate Critical Apparatus Dialog). 
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Toggle Location Markers - Toggles location marker display in the 

Document Panel for lines (or stanzas if these are marked). 

 

Re-Collate - Documents are collated automatically when a new 

document is added or removed from the Comparison Set. This is only 

needed if you want to change the options, such as ignoring punctuation. 

 

Search Text In Files - Type in the input box and click on the icon to do a 

search of a particular term or terms in all documents in the comparison 

set. Note that you can see a list of recently searched for terms by clicking 

the triangle just to the right of the input box. 

 

 

Comparison Explorer 

 

The Comparison Explorer displays 

all documents in the current 

comparison set. These documents 

are automatically collated against 

one another.   

 

 

Documents can be added or removed from the list by using the Add 

Document and Remove Document buttons on the toolbar. The display 

name of a document can be modified by editing its “short name” field in 

the Bibliographic Info Dialog. 

 

The document highlighted in green is the current base document, from 

which comparisons are made. Each of the documents has a meter to the 
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right indicating its degree of difference from the base document. Placing 

the mouse pointer over a given document reveals this value expressed as 

a number.  

 

To the left of the document name is a checkbox. Deselecting a checkbox 

temporarily excludes the document from the collation results. This 

exclusion is applied throughout the rest of Juxta's computations and 

outputs. For example, excluded documents do not appear in the critical 

apparatus output. 

 

 

 

Document Panel 

The Document Panel can 

display the results of an entire 

collation or it can zoom in on a 

specific comparison between 

two documents. To facilitate 

this, the Document Panel has 

two modes: Heat Map View 

and Comparison View.  These modes can be toggled with the tabs at the 

bottom of the panel.  

 

Line numbering and other markings can be summoned by clicking on 

the “Toggle Line Numbers” button on the toolbar.  

 

When the Heat Map View is selected, Juxta displays a collation against 

the current base document.  The current base document is the document 
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highlighted in green in the Comparison Explorer to the left of the 

Document Panel. 

 

The text is color coded to indicate the degree of variance evident at any 

particular area of the text.  Lighter shades of blue indicate that fewer 

witness vary from the base text at this location.  The darker the shade of 

blue, the more witnesses differ at this location.  

 

 

 

 

Clicking on the text itself reveals all variants for a particular location.  

The variants display in the right hand margin of the text as depicted 

below: 

 

 

 

When such variations are displayed one can add critical annotations.  

The operation is initiated by mousing over the witness label (displayed in 

green) and clicking the grayed-out star that appears on mouse over.  This 

will display an “Edit Note” box where the annotation is entered.  Saved, 

the note appears in the Secondary Panel below the Document Panel.   

When an editorial note has been entered about a specific variant, the 

grayed-out star is displayed in bold ( ) and remains on display if the 

comparison set is saved.  
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There are three types of differences reported by Juxta.  As the image 

illustration above shows, they are marked with the following glyphs: 

 

— Indicates a difference between base and witness text at this 

location. 

— Indicates that there is text present at this location in the witness 

text where there is no such text present in the base text. 

— Indicates that there is text present in the base text that is not 

present at this location in the witness text. 

 

If the user clicks on a difference when in Annotation Mode the Edit Note 

dialog will appear.  

 

The Comparison View allows for side-by-side inspection of two texts. 

While the Heat Map View permits the user to view the status of the base 

text relative to all of the other texts in the collation, the Comparison 

View focuses on just two texts at a time. As the user scrolls through the 

comparison, the two texts are kept in step with one another.  The user 

can easily flip back and forth between the Heat Map View and the 

Comparison View by selecting a highlighted difference from either text. 

Line numbering and other markings can be summoned in this view by 

clicking on the “Toggle Line Numbers” button on the toolbar.  

 

Choosing “Toggle Fragment Selection Mode” in the Toolbar allows one 

to select specific passages in different documents for collation.  Choose a 

document from the comparison set and mouse over the desired area, 

which will appear in red.  Once the new set of selected comparisons 

have been chosen, switch the Document Panel to Comparison View and 
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follow the directions for resetting the comparisons to the specific 

selected areas.  The Comparison View will grey out all parts of the 

documents except the selected areas.  These specially selected text 

comparison sets can be deleted by selecting the “Toggle Fragment 

Selection Mode” icon and then clicking on the red-selected area in the 

base text view for each of the selected witnesses. 

 

 

Secondary Panel 

The Secondary Panel houses 

supporting information relevant to 

the document or documents 

currently being displayed in the 

Document Panel. The Secondary 

Panel has three modes: Notes 

View, Image View, and Passages view. These modes can be selected by 

clicking on the tabs at the bottom of the panel. 

 

The Notes View is a table of the annotations that the user has recorded 

for this comparison set. For each annotation, the following columns of 

information are displayed: 

 

Base Text – The base text for the difference this note marks. 

Witness Text – The witness text for the difference this note marks. 

Lemma – The text heading that heads the list of variants. 

Notes – The text of the annotation itself.  

 

The Notes View also has a toolbar housing the Document Tracking 

Mode Button and the Delete Note Button. When the Document Tracking 
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Mode Button is depressed (which is the default behavior) the Document 

Panel automatically repositions to display text corresponding to the 

currently selected note. The Delete Note Button deletes the currently 

selected note or notes. Double clicking on a note in the Notes View 

brings up the Edit Note Dialog for the selected note. 

 

The Image View displays an image associated with the text presently in 

the Document Panel. The Image can be panned and zoomed using the 

buttons on the toolbar below the image area. Images are associated with 

location markers or milestones in the process of importing a document in 

XML format (described below). 

 

When the Passages View is selected, the display area shifts.  To select a 

passage put the mouse at the start of the passage to be selected and 

click.  This will segment the witness text and the selected area will be 

signaled with relevant information under the columns in the viewing 

window.  The text can be segmented as many times as one wishes and 

from any point.  The “Passages” bar that appears above the viewing 

window displays a graph of the segmentations; clicking on a segment in 

the that display graph or in the viewing window shifts the Document 

Display to the appropriate position.  To annotate the chosen passage, 

double click the selection in the viewing window and an Editing Notes 

box will appear. 

 

All annotations and selections can be deleted using the delete icons at 

the lower right of the viewing window. 
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Add Document Dialog 

 

The Add Document Dialog allows 

the user to add a document to the 

comparison set. Documents can be 

imported either as plain text or as 

XML files. If plain text is selected, 

then the text is assumed by default to 

be UTF-8 encoded. Alternate text 

encodings can be selected in the encoding drop down box in the lower 

right of the dialog. If a Juxta XML document is selected, then the 

encoding is determined by reading specifications inside the XML file. 

The bibliographic data for TEI and Juxta XML files can be previewed to 

the left of the file chooser. Selecting a document adds it to the collation 

and re-collates the comparison set to take into account this new 

addition. 

 

 

Bibliographic Information Dialog 
 

The Bibliographic Information Dialog can 

be summoned by clicking on the 

Bibliographic Info Button on the toolbar. 

This dialog allows the user to view and 

update the bibliographic information for 

the currently selected document. The short 

title displayed here is used to identify this document in the Comparison 

Explorer and is also used as the witness sigla for this document in an 
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exported critical apparatus. In fact, the entirety of the bibliographic 

information is output as part of the critical apparatus. 

 

 

Edit Note Dialog 

The Edit Note Dialog allows the 

user to view and update the 

currently selected note. 

Checking the “Include Image” 

box adds a link to the base-

text's image for this note in the 

critical apparatus. The image is 

obtained from the XML location 

marker that denotes the location of this difference. 

 

 

Find Dialog 

The Font Dialog can be 

summoned by selecting View-

>Change Text Font from the main 

menu or by pressing Ctrl-T (or 

Apple-T on a Mac). This dialog allows the user to control the display font 

for the text in the Document Panel. 
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Collation Histogram Dialog 

The Collation Histogram dialog 

displays a graph of the frequency of 

difference over the length of the 

currently selected document. The 

green highlighted area depicts the 

portion of the document currently 

visible on the screen. The short name of the currently selected document 

is displayed below the graph. 

 

Also below the graph is the Filter Strength Slider. This slider allows the 

user to temporarily filter out minor differences in spelling and 

punctuation in order to reveal more substantive differences. This feature 

is especially useful in large documents with many minor changes. 

 

Collation Dialog 

When documents are added to the 

comparison set, Juxta 

automatically collates them 

against all of the other documents 

in the set. The Collation Dialog is 

useful when you wish to re-collate the comparison set with new filter 

settings. The following filters are available: ignore white space; ignore 

punctuation; and ignore case.   
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The  Pe r i l s  o f  “P la in  Tex t ”  

There is one thing that every scholar manipulating and preparing digital 

texts should know about “plain text” files:  there is no such thing as a 

plain text file. All text files, whether they explicitly specify it or not, are 

encoded when they are saved to disk. Possible encodings include “utf-8” 

and “cp-1252” formats.  

 

This fact can cause problems as the file moves from one computer and 

operating system to another. This is because different computer 

operating systems make differing assumptions as to how “plain text” or 

“ascii” files are encoded. For example, files prepared on Windows 

machines with applications like Notepad can generate code in the CP-

1252 format, which is a Microsoft Windows™ specific encoding. If these 

files are then shared across the network to a Mac computer and opened 

as “plain text” they may be corrupted on the screen. Characters such as 

“ö” and “æ” may appear like this:  	
�   

 

We recommend using a cross-platform compatible encoding format such 

as UTF-8. When Juxta loads plain text files, it assumes that they are 

encoded in this format. Most text editing programs will allow you to 

specify the encoding type of a plain text file. For example, to generate a 

UTF-8 encoded text file from Microsoft Word 2002, take the following 

steps: 

 

1) Select “Save” or “Save As..” and then select “Plain Text (.txt)” as the 

type of the file. 
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2) The dialog below will appear. Select “Other encoding” and then 

select “Unicode (UTF-8)” from the list of encodings. 

 

 

 

3) Click OK to save. 
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Juxta also allows the user to specify the encoding of files when they are 

loaded. See the section on the Add Document Dialog for more info. 

 



 
 

Juxta Manual: 20 

 
 

C red i t s  

Juxta was developed by ARP (Applied Research in Patacriticism) at the 

University of Virginia in Charlottesville, VA. Development of Juxta was 

made possible by a grant from the Mellon Foundation.  

 


